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QUARTUS SW INSTALL AND TESTING INSTRUCTIONS

1.1 FOR THE WINDOWS SYSTEMS

1. Link for Download (You will have to register, before downloading)

https://fpgasoftware.intel.com/

Currently go for version 20.1 (Lite) version which is free. Download file size is around 2GB, while the total
install size (Quartus, ModelSim, Device files) is around 14 GBytes and it takes about an hour, for the

installation!

You may have to disable your virus protection, while downloading and installing. Due to download sizes, it
might be better to download Individual Files, instead of the combined files.

In that case, download the following files individually and install them sequentially.

Quartus Prime Lite Edition (including the NIOS EDS)

For using the DE10-Lite board, you will also need to install the..

Max 10 FPGA device support file. (if you download this file, at the time of Quartus install,
this driver would get installed automatically)

**Note**, if you have already downloaded the device files, Quartus at the time of it’s Install will
give you the option to install the downloaded Device files also, the same time.

ModelSim Intel FPGA Edition
**Note**, when installing ModelSim, point it to the same directory, where you installed Quartus,
e.g. C:\IntelFpga_lite\20.1 or as per your own case.

For your reference, also download the ‘Intel Quartus Prime software, User Guide’ This document will help
you get acquainted with the software’s IDE.

Use one of the following links:

https://www.intel.com/content/www/us/en/programmable/products/design-software/fpga-
design/quartus-prime/user-guides.html

https://tinyurl.com/y7xaw5u4

1.1.1 INSTALLING QUARTUS AND MAX 10 DEVICE FILES
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Specify the Install Directory

If already downloaded Max10 Device file, check it off
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Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer. -

*fou can now connect your device to this computer. f your device
came with instructions, please read them first

Driver Name Status

\/ fltera (WinUSB) JTAG cables (10/13/2018) Readyto use

Cancel H

< Back

—

USB Blaster driver is installed correctly.

1.1.2 INSTALLING MODELSIM

(3 Installing MedelSim - Intel FPGA Edition or Starter Edition Model Technology ModelSim - Intel F...  — a X

Setup - ModelSim - Intel FPGA Edition or Starter Edition Model Technology ModelSim - Intel FPGA
Edition vsim 2020.1 (Quartus Prime 20.1.0.711) (22-hit)

Veicome to the ModsiSim - Intel FRGA Edion or Starter Ediion Model Technology Mode!Sim - Intsl FRGA
Edition vsim 2020.1 (Quartus Prime 20.1.0.711} (32-b#) Setup Wizard.

For more information about Intel FRGA scftware, go to

Check that you see Max 10 Family and Installed Libraries -

(3b Installing ModelSim - Intel FPGA Editien or Starter Edition Model Technology ModelSim - Intel . —

Select the ModelSim edition you like to install

(® ModelSim - Intel FPGA Starter Edition
- License & not required.

(O Modelsim - Intel FPGA Edition
- License s required.

InstallBuide

Select the free ‘Starter’ Edition




b Installing ModelSim - Intel FPGA Edition or Starter Edition Model Technology ModelSim - Intel ...  — O X

(G Installing ModelSim - Intel FPGA Edition or Starter Edition Model Technology ModelSim - Intel F..  —

Installation Directory

‘Specify the directory uhere Mode!Sim - Intel FRGA Starter Edifion 20.1.0.711 vl be installed

You can view the fullbeense agreement at the fink below. You must accept the terms of the agreement befare continuing with the installation
itps/ fpgssoftviareintsl.comeulal

Installaion Directory | D:\intelFPGA_i#=\20.1

88. quickserver 1.4.7 (LGPL v.2.1 License) ~
89. swingworker 3 (MPL v. 1.1 and LGPL v. 2.1 Licenses)

90. symphony 5.4.5 (Eclipse Public License v. 1.0)

91. systemc 2.2.0 (SystemC Open Source License v. 3.3)

92. velocity 1.4 (Apache v. 2.0 License)

93. wraplf 0.2 (Apache v. 2.0 License)

94. xalan 1.2.2 (Apache v. 2.0 License)

95. xerces-c 3.2.2 (Apache v. 2.0 License)

96. xerces 2.12.0 (Apache v. 1.1 License)

97. xmlbeans 2.2.0 (Apache v. 2.0 License) v

@ 1.5ccaptthe agresment

Do you accapt this bens?
(O 1do not accent the agreement

(G Installing ModelSim - Intel FPGA Edition or Starter Edition Medel Technelogy ModelSim - Intel F...  — a X

Ready to Install

Summary:

Installation diractory:
Required disk space: 4340 ME
Avalable disk space: 320276 ME

InstzllBuilder

Last step, before the install begins.



1.2 USB BLASTER DRIVER, INSTALL AND CHECK

**Note**, if the USB Blaster is not installed properly, you won’t be able to Program your DE10-Lite board!

The USB Blaster driver is included in the download for the Quratus Prime itself. Verify that you do have a folder
by the name usb-blaster-ii under this path, where text in blue is, as per your own unique case.

your_drive:\intelFPGA _Lite\20.1\quartus\drivers

If run into trouble with your USB driver and are having trouble communicating with the Board, check these
instructions:

https://www.terasic.com.tw/wiki/Altera_USB_Blaster_Driver_Installation_Instructions

https://mil.ufl.edu/3701/docs/quartus/byteblaster/usb-blaster_driver_install.pdf

1.3 TEST QUARTUS INSTALL AND USE THE IDE

Perform the steps under this section...

1) To ensure that your SW installation went fine and

2) Get familiar in using Quartus IDE, for doing your labs. Having the Quartus Prime SW, user guide handy,
would be useful.

This section assumes that you have successfully installed Quartus SW, Max 10 device support files and the
USB Blaster driver.

1.3.1 NEw PROJECT WIZARD

Start Quartus SW, from the desktop shortcut or from Windows Start menu.

1. Open a New Project Wizard, by selecting
File -> New Project Wizard You would see the following screen..

Introduction

The New Project Wizard helps you create a new project and preliminary project settings, including the
following:

Project name and directory

Name of the top-level design entity

Project files and libraries

Target device family and device

EDA tool settings
‘You can change the settings for an existing project and specify additional project-wide settings with the
Settings command (Assignments menu). You can use the various pages of the Settings dialog box to add
functionality to the project.

[ on't show me this intreduction again

< Back Finish Cancel Help

Click on ‘Next’ and you will see the screen shown below....



https://www.terasic.com.tw/wiki/Altera_USB_Blaster_Driver_Installation_Instructions
https://mil.ufl.edu/3701/docs/quartus/byteblaster/usb-blaster_driver_install.pdf

¥ New Project Wizard

Directory, Name, Top-Level Entity
‘What is the|working directory for this project?

C:/MyProjects/Quartus20p1/DE10Lite/StairSw

Whatis theof this project? I

Threewaysw

‘What is the name of the top-level design entity|for this project? This name|is case sensitive and must exactly |

match the entity name in the design file.

Light

Use Existing Project Settings...

i Directory "C:/MyProjects/Quartus20p1/DE10Lite/Stairsw"

4 N
&= ' " does not exist. Do you want to create it?

< Back Next > Finish Cancel Help

On this window, fill out...
a) The path and the name of the directory, where you want the project to be created and stored.
b) The name of your project
c) The name of the Top Level module, in your Project. It is important that the name is entered
exactly, including the case, as it in your code, so that it matches.

If the working directory is not existing, you will get a message, asking for your permission to create the
directory. Click Yes and then go to the next screen, by clicking Next.

New Project Wizard

Project Type

Select the type of project to create.

O] Empty project

Create new project by specifying project files and libraries, target device family and device, and EDA tool l
settings.

) Project template

Create a project from an existing design template. You can choose from design templates installed with
the Quartus Prime software, or download design templates from the Design Store.

< Back Next > Finish Cancel Help

Use the default Empty Project setting and click Next. This takes you to the tab, for adding files, to your project.



Add Files

Select the design files you want to include in the project. Click Add All to add all design files in the project
directory to the project.

| Note: you can always add design files to the project laIer.l Browse to your files

File name: |E| Add

(o X|| addau

File Name Type Library Design Entry/Synthesis Tool HDL Version Remove

Up
Down

Properties

Specify the path names of any non-default libraries.

| < Back ‘ | Finish H Cancel H

For the time being, we won't add files here, in this step. Note, you can always add files to the project, later also.
Click Next, to proceed to wizards’ next step.

Family, Device & Board Settings

)
Device Board

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in 'Available devices' list
E Family: MAX 10 (DA/DF/DC/SA/SC) -l Package: [raca 7
) Device: [MAX 10 DA | pincount: [a8a -
Target device Core speed grade: ‘7 - ‘
Auto device selected by the Fitter Name filter: ‘ ‘
- ® Specific device selected in *Available devices' list Show advanced devices .
! other: n/a

Available devices:

Name Core Voltage LEs Total 1/0s GPIOs Memory Bits d multiplier 9-bit PLLs Global Clocks Maximi
g 10M16DAF48417P 1.2v 15840 320 320 562176 90 4 20 4587520
10M25DAF484A7G 1.2v 24960 360 360 691200 110 4 20 6291456
10M25DAF484C7G 1.2v 24960 360 360 691200 110 4 20 6201456
E TOM25DAF48417G 1.2V 24960 360 691200 110 4 20 6291456 =
N 10M40DAF484C7G 1.2v 40368 360 1290240 250 4 20 1153433€
n TOM40DAF48417G 25 4 20 1153433¢€ -
TOM50DAF48417G 360 1677312 288 4 20 1153433¢€
TOM50DAF48417P 360 1677312 288 4 20 1153433€ v
< >

<Back | Next > h Finish | | cancel || Help
| —

This is an important tab. For DE10-Lite board, fill out as shown above and click Next.



a Mew Project Wizard

EDA Tool Settings

Specify the other EDA tools used with the Quartus Prime software to develop your project.

EDA tools:
Tool Type Tool Name Format(s) Run Tool Automatically
Design Entry/Synth... | <None> ¥ | <Mone> Run this tool automatically to synthesize the current design
Simulation ModelSim-Altera ~ | verilog HDL [I] Run gate-level simulation automatically after compilation
Board-Level Tirming <None>

Symbol <None>

Signal Integrity <None>

Boundary Scan <Mone>

ni

Summary

Project directory:

Project name:
Top-level design entity:
Number of files added:
Number of user libraries added:
Device assignments:
Design template:
Family name:
Device:
Board:
EDA tools:
Design entry/synthesis:
Simulation:
Timing analysis:
Operating conditions:

Core voltage:

Junction temperature range:

‘When you click Finish, the project will be created with the following settings:

C/MyProjects/Quartus20p1/DE10Lite/Stairsw

ThreewaySw
Light

0

0

n/a
MAX 10 (DA/DF/DC/SA/SC)
TOM50DAF484C7G

n/a

<None> (<None>)
<None> (<None>)

0

1.2V
0-85°C

Next >

Finish |

‘ Cancel H

Help

Do the same for this last slide and click Finish.




1.3.2 ADDING FILES

After you have done the above steps, Quartus would show you a view like below, showing only your Top level
Module, as you declared it in the previous steps, since no files and lower hierarchy modules are currently
present.

File Edit View Project Assignments Processing Tools Window Help

D E[* 00" C[ifugh G /ESE D EKS OAVE S

Project Navigator ([ ierarchy - [jims =
Entityinstance

o ax 10 10m500AF484C7G | oo ot our Top Level
Module

< >

Tese Complaton <J=ime -

Task Time

To add the files, you would do the following steps...

5
File Edit View Project Assignments Processing Tools Window Help

Dr 8|+ D0 2 C|iug frescorriS OaVE S

Project Navigator (1B ~hiEs -

E % Add/Remove Files in Project...

[Tasks Compilation =M= x

Task Time

4 b compile Design
o B Analysis & Synthesis
» B Fiter (Place & Route)
o B> Assembler (Generate programming files)
> B Timing Analysis
> B EDA Netlist Writer
B Edit Sectings
& Program Device (Open Programmer)

(] [&] [a] [A] [¥ <<Filter> ] 88 Find.. | 88 Find Next

Tvoe ID Messade

TR

Select Files from the drop down menu. Right click on the ‘Files’ under the Project Navigator and select
‘Add/Remove Files in Project’

Category:

»1/DE10LI irSw/Tl - Light
/Board..

Select the design files you want o include in the project Click Add Al © add all design fies in the
Libraries e s 3 .
project directory to the project Click, to browse for your file/s

< 1pserings
1» Gl Search Loct @)
a Conciti | L %[ adaau

Design Templates
Voltage File Name Type Library Design Entry/Synthesis Tool HDL Version
Temperature

4 Compilation Process Settings
Incremental Compilation

4 EDA Tool Settings
Design Entry/Synthesis

File name:

Remove

A« MyProjects » Quartus20p1 » DETOLite » Stairsw » v & | Searchstairsw »

e e Organize = New folder ) =- m @
Soard-Level % Favortes A O Name Date modified
4 Compler Setiings

HDL nput ) do 20201217 1158.._Fi
Verilog HOL Input 3 Homegroup | Lighty 2020-12-17 1246 v
Default Parameters

Timing Analyzer & This P

Assembler Je Desicop

Design Assistant B Documents

Signal Tap Logic Analyzer B Donioscs

Logic Analyzer Iterface

Power Analyzer Settings b Music

SSN Analyzer & pictures

B Videos

% Windows (C)

< KINGSTON (D)
Vo< >

. s e rame:ights | [Dosgn st and e v

=
= [roe T essace [Lomn ]|\ como |

=

system | processing |

Browse to the directory which contains your HDL (Verilog, VHDL, SystemVerilog) file. In the case shown a Verilog
file called Light.v is visible. This file was previously created and saved under the project directory.



Here is the sample code in this file (Credit: Altera document ‘Quartus Il Introduction Using Verilog Design’). Using
a texteditor of your choice, you can copy and save this file, under the directory, from where you want to import it,
preferably your project directory, into your project. (Pay attention to the name of the module!)

module Light (x1, x2, f);
input  x1, x2;
output f;

assign f=(x1 & ~x2) | (~x1 & x2);
endmodule

This is design of a simple two-way light controller, which we typically find in our homes, on stairs. Below is the
diagram and Truth table of this circuit.

*

—

A 7 .
1
1

-0 = o

*2

Figure 12. The light controller circuit.

When you click ‘open’ on the last picture shown above, and then click ‘Add’, you see the following window...
**Note**, you can open multiple files, in one go. In that case, click on ‘Add All’, so that they get added to the
project.

Category: Device/Board.
General I

Hlles select the desig files you want to include in the project. Click Add All o add all design files in the
Libraries project directory to the project.
4 1P Settings
1P Catalog Search Locations | File name: -] A
Design Templates « ®
4 operating settings and Conditic
Voliage File Name Type Library Design Entry/Synthesis Tool HDL Versia] remove

Add All

Temperature Lighty. Verilog HDL File <None> Default
4 Compilation Process Settings up
Incremental Compilation
4 EDA Tool Settings
Design Entry/Synthesis Properties
simulation
Board-Level
4 Compiler Settings
VHDL Input
Verilog HDL Input
Default Parameters
Timing Analyzer
Assembler
Design Assistant
Signal Tap Logic Analyzer
Logic Analyzer Interface
Power Analyzer Settings
SSN Analyzer

Quartus Prime|

< >

< > "BuySuftwsreL oK J Cancel Apply || Help

=Tvoe lessade

Nz

System | Processing

Click ok and the file/s are added to the project. When we do it, the following screen is seen and you see that our
file Lights.v has been added to the project.



o Quartus Prime Lite Edition - C:/MyProject DE10L i - Light
File Edit View Project Assignments Processing Tools Window Help

7 ¢ [{[ugm /S TrHERD QAVE @

D a3
Prolect Navigator | [1= Fies s -
" Files

B Lighty
[Tasks Compilation ~=[ms =

Task Time

4 P Compile Design

B Analysis & Synthesis .

b Fiter Plce & Route) Quartus Prime

b B Assembler (Generate programming files) o

> B Timing Analysis - —
P> EDA Netlist Writer
W Edit Settings

& Program Device (Open Programmer)

(0] [&] (4] [A] [¥ <<Fiter> 88 Find.. | |#8 Find Next

Twoe ID Message

WEa x

1.3.3 COMPILING THE DESIGN

After we have added the file/s the next step is to compile the design, fix any errors, look at the warnings and
preparing the design, for checking / testing on the board.

Right click on the ‘Analysis & Synthesis’ step, under the Compile Design options, and select Start.

5

File Edit View Project Assignments Processing Tools Window Help

DrsE |+ D02 C i[ug C|ses e 0P QAR O
Project Navigator [ tierarchy - i =
Entity:nstance
[ Max 10: 10Ms0DAF4B4CTG
ight
< |
rasks | Compilation ~ s
Task Time

4 B compile Design
> > Analysi

e Quartus Prime

b B Assembler|
o B Timing An: @ stop Processing crrl+shift+C 0.1 Lite Editio
» P EDANetlis  EditSetings
B ditSettings | yiew Report

S roganoent

Collapse All
Edit Flow...
New Flow...

>|

(] [0 [&] (4] ¥ <<Filier> 88 Find.. | 8 Find Next|

Tvoe ID Message

Wi «|[~

Messages

System | Processing

After the compilation step is complete, if there are any errors, fix them. Also closely look at the error and warning
messages, as they often provide good clues to where the problem / potential problems lie in your code.



File Edit View Project Assignments Processing Tools Window Help

Ord D Light | ESL DRSS OADE O
Project Navigator A\ Hierarchy ~aex | @ Compilation Report - Light FEK: Lighty
n Ber LN 7N
1 wodule Light (1, x2, £);
A MAX 10: 10M50DAF484C7G 2 input x1, x2;
® ghe e 3 output
N 4 8 issing i " ~
H assign F - (L & x2) | O & x2); Line#5 has g inverting symbols
6 endnodule Don't use this!
< >
[Tasks Compilation ~|=@s <
Task Time

4> compile Design

> B Analysis & Synthesis 0000:52

P Fitter (Place & Route)
> B Assembler (Generate programming fles)
> B Timing Analysis
P EDA Netlist writer
W Edit Sertings

& Program Device (Open Programmer)

(Check these Tabs, for Errors, Warnings and System messages

A] [¥ <<river> 88 ind_. | 88 Find Next

ID  Message

Voe
°
>0 Running Quartus Prime Analysis & Synthesis
Command: quartus_map --read_settings_files-on --write_settings_files=off Threewaysw -c Light
1 18236 Number of processors has not been specified which may cause overloading on shared machines. set the global assignment NUM_PAR/
© 20030Parallel compilation is enabled and will use 2 of the 2 processors detected
> @ 12021Found 1 design units, including 1 entities, in source file Tight.v
© 12127 Elaborating entity "Light" for the top level hierarchy
© 286030 Timing-Driven Synthesis is running
> © 16010 Generating hard_block partition "hard_block:auto_generated_inst"
> © 21057 Inplemented 4 device resources after synthesis - the final resource count might be different
>0

[[@artus prime Analysis & synthesis was successful. 0 errors, 1 warning-]

<

Messages

System  Processing (11)

After the compile result is satisfactory, the next step ususally is to lock the Pins (aka assigining the input, output
ports of the design, to specific pins of the FPGA chip), so that the design, when ready can be tested on the
board. This simple design only has three ports, so please assign manually, as shown in the picture below.

**Note**, when the design has many ports, it is often fasters and less error-prone, to ‘import the pin assignments.
How to do this shall be explained later, in more detail. For now, manually assign the ports x, y and f, to the pins,
as shown below.

First, open the Pin Planner tool, as shown.

Eile Edit View Project | Assi Processing Tools Window Help
OmE“mnn (Y Device YO OavH @
Project Navigator " setings.. CELSHILE Compilation Report - Light o ® Lighty
& Assignment Editor Curl+shift+A e 0w P 8=

ight (1, x2, );
nput x1, x2;

\ MAX 10: 10M50DAF4ga( @ Pl Planner cutsshiftn

™ g e Remove Assignments... utput f;
I5 Back-Annotate Assignments... ssign F = (<L & x2) | L & x2);
Import Assignments... dule
< Export Assignmens..
Fasks Assignment Groups...
8 LogicLockRegions Window  Alt+L
4 b Compile Design *®_Design Parttions Window Alt+D
v > Analysis & Synthesis 0000:52

> Fitter (Place & Route)
> B> Assembler (Generate programming files)
> B> Timing Analysis
> P> EDA Netlist Writer
B it Serings

& Program Device (Open Programmer)

Al (O] Al|A| (A |V <<Filer>> 88 rind... | 88 Find Next

WEa x|~

Tvoe ID Messaae
i 18236 Number of processors has not been specified which may cause overloading on shared machines. Set the global assignment NUM_PAR

Then in the Pin Planner tool, manually assign the pin locations, to the three ports.



Flle Edit View Processing Tools Window Help

et o u- Top View - Wire Bond
% MAX 10 - TOM50DAF484C7G
¥
o
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[
E
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= [resks ae
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2 B Eariy Pin Planning..
I8 P Run 10 Assignment Analysis
“ [ LA —
©| W einFnder
: 4 - Hignlight Pins
3 £ 10 Banks
m] 2 VREF Groups
=k
47 ok Pins

B Clock

= PLLIDLL Input QDG
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s/ SR EAD TR ) 3""

¥ Clock Region input

4 Memory Pins s r_l
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o npin et |7 wmo |avom s e

AllFins

After this step, close the Pin Planner tool and then we will do a complete Compile Step on our design.
Once the compile step is successfully done, you would see green check marks, next to the four main steps of
the design compile process, as shown below.

Tt fEn Gew Fmen Amgmes Mosng Tou o 6o ST—

1 [ Lt et BrERL Bi0u .
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MAX 10 TOMSULAFRULCHG L3
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a1 setng 201 Bl 71 003252051 L Eton
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| o
S
o st
o
. J Torl memory oirs 0/1ATIAZ10%]

Embedes Mutper 3-bi slemens 0,269 (07%)

W Earserings TomlpLis 0/410%)

@ Prozram Device (Open Prosrammen UFM Bischs LYRIEE)

ADC blocks o/2(0%

< T swiich betsenen Wornings, Eriors and Sysiem 2 < 2 (e
a|m [0 [& ¥ Mo, marne

SeT e glota) sssfauent W PARALLEL PROCESSOLS §n your T to an sporcpriate valu
Tobal B L T
Subzcription 5 gatn full access £ this faatire

s required by the Tining analyzer to get proper Timing constraints. without it

B e
11 F11e not found: "LIGNE Sdc": A SYIOpSys Destn ConsEraints Fils 5 required by the TINING ARGIyZer o get proper FIWIng CONStrains. WiEhOUE 1T,

Warning meszagez, in Blue

You may notice, that the Timing Analyzer is in red. This is because we do not have any clocks in our design
and as such no clock timing information was used. This can be safely ignored.

1.3.4 PROGRAMMING THE BOARD

After the compile step is over, it is time to program the board and test the design on the board. For this we
need to use the Programmer tool.

**Note**, Before attempting this step, the DE10-Lite board should already be connected to your laptop, via
the USB cable. When the board is powered up, the Hex displays shows numbers between 0 and F, while the
LEDS blink on and off, in a rotoary form.

Do menu Tools -> Programmer (or click on the Progammer icon) and you would see the following
window.



T T

— ¥ Programmer - C:/MyProjects/Quartus20p1/DE10Lite/StairSw/ThreeWaySw - Light - [Light.cdf] -8

= Eile Edit View Processing Tools Window Help Search altera.com .
y
|

rec || 2 Hardware sewp-. o raraware |
|
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Make sure, that Mode is JTAG!

Initially under Hardware Setup, you may see ‘No Hardware’. If this is the case, double click on Hardware
Setup, to open it's window. If your USB Blaster driver was installed properly, you will see USB-Blaster
available. Double click on it, so it becomes the ‘currently selected hardware’ and then Close the window.

You should now be back into the Programmer Tool, with USB-Blaster now visible, as shown below.
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Make sure, Program / Configure is checked off, next to your SOF file.

**Note**, if you don’t see the SOF file automatically selected, click on ‘Add File’ and browse your project’s
Output directory and select your SOF file, so that it gets added to the Programmer.

Click Start and programming of your board shall starts. If everything went well, the Progress bar should get
completely full with a green bar.



During programming, you will see that the ‘Load’ LED on the board lights up, as shown below.

Board being Programmed.

1.3.5 TESTING DESIGN ON BOARD

This design is a simple two-switch controller, commonly seen around stairways. The X and Y inputs are the
switches SW1 and SWO0, while the F output is going LEDRO.
When the design is working properly, you will notice results, as shown below.

i 7

Xis on, Y is off. The Light is on. Both X and Y are on, the Light is off.

By completing these steps, you have verified your setup and are now ready for your Labs!

1.3.6 A SMALL TWEAK

You would have noticed that in the pictures above, the 9 LEDs to the left of LEDRO are also dimly lit up.

If want to correct this, go to menu Assignments -> Device



Then follow the steps, as outlined in the picture below. Apply these changes. Re-compile and re-program your
design and now those un-used LEDs won'’t light up.
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1.4 OTHER USEFUL LINKS

This is Intel's User forum, which includes useful info on the FPGA related matters too. You can post your issues
and search for previously posted / resolved similar issues.

1. https://community.intel.com/ You will be required to Register, to use if fully.


https://community.intel.com/

2

INSTRUCTIONS FOR THE MACOS SYSTEMS

There are few options for running Quartus on a Mac. The steps in the link below have been tested and tried
during a previous school term and are recommended, with few extra points, as mentioned below.

Prior to following the steps mentioned in the link below, you would require Ubantu Desktop running in
Virtualbox.

1. Install VirtualBox from this link
https://www.virtualbox.org/

After you complete the install of the Virtual Box, you should also install the "VirtualBox Extension
pack”.

For that, follow instructions on this link:
https://lwww.nakivo.com/blog/how-to-install-virtualbox-extension-pack/
2. Then install Ubantu from this link
https://ubuntu.com/download/desktop

3. Thereafter follow the steps mentioned under this link, however make sure to keep extra ‘virtual disk
space’ as mentioned below.

https://siytek.com/quartus-mac-virtualbox-ubuntu/

However make following changes in these sections
- Sec 3.1 Recommended virtual disk space’

Set the virtual box disk space to 50GB to allow enough space for Quartus, instead of 30GB in the
online link. Additionally, create this space on your MAC itself and not on an external hard drive.

- Sec 4. Install Quartus
Download version 20.1 Lite, for Linux (Registration is required)

Make sure you also download and install ModelSim Altera and Max10 device files.

- Thereafter follow sections 5 and 6, as per the link.

After these steps, to verify your setup, follow the steps in Section 1.3 of this tutorial, “Test Quartus Install and
Use the IDE”

If you run into any issues with install or in verifying your setup, report it to this email:

tech@eecs.yorku.ca


https://www.virtualbox.org/
https://siytek.com/quartus-mac-virtualbox-ubuntu/
mailto:tech@eecs.yorku.ca
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